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Notice

The information contained in this document is subject to change without notice.

Hewlett-Packard makes no warranty of any kind with regard to this material,
including but not limited to, the implied warranties of merchantability and
fitness for a particular purpose.  Hewlett-Packard shall not be liable for errors
contained herein or for incidental or consequential damages in connection with
the furnishing, performance, or use of this material.

© Copyright Hewlett-Packard Company 1997

All Rights Reserved.  Reproduction, adaptation, or translation without prior
written permission is prohibited, except as allowed under the copyright laws.

1400 Fountain Grove Parkway, Santa Rosa CA 95403-1799, USA

Microsoft® is a U.S. registered trademark of Microsoft Corporation.
WindowTM is a U.S. trademark of Microsoft Corporation.
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Hewlett-Packard Software Product License

Agreement and Limited Warranty

Important!

Please carefully read this License Agreement before opening the media
envelope or operating the equipment.  Rights in the software are offered only on
the condition that the Customer agrees to all terms and conditions of the
License Agreement.  Opening the media envelope or operating the equipment
indicates your acceptance of these terms and conditions.  If you do not agree to
the License Agreement, you may return the unopened package for a full refund.

License Agreement

In return for payment of the applicable fee, Hewlett-Packard grants the
Customer a license in the software, until terminated, subject to the following:

Use

•  Customer may install the software only on one computer at one time.

•  Customer may not reverse assemble or decompile the software.

Copies and Adaptations

•  Customer may make copies or adaptations of the software:

◊ For archival purposes

◊ When copying or adaptation is an essential step in the use of the
software with a computer so long as the copies and adaptations are
used in no other manner.

•  Customer has no other rights to copy unless they acquire an appropriate
license to reproduce which is available from Hewlett-Packard for some
software.

•  Customer agrees that no warranty, free installation, or free training is
provided by Hewlett-Packard for any copies or adaptations made by
Customer.

•  All copies and adaptations of the software must bear the copyright
notice(s) contained in or on the original.



iv

Ownership

•  Customer agrees that they do not have any title or ownership of the
software, other than ownership of the physical media.

•  Customer acknowledges and agrees that the software is copyrighted and
protected under the copyright laws.

•  Customer acknowledges and agrees that the software may have been
developed by a third party software supplier named in the copyright
notice(s) included with the software, who shall be authorized to hold the
Customer responsible for any copyright infringement or violation of this
License Agreement.

Transfer of Rights in Software

•  Customer may transfer rights in the software to a third party only as part of
the transfer of all their rights and only if Customer obtains the prior
agreement of the third party to be bound by the terms of this License
Agreement.

•  Upon such a transfer, Customer agrees that their rights in the software are
terminated and that they will either destroy their copies and adaptations or
deliver them to the third party.

•  Transfer to a U.S. government department or agency or to a prime or lower
tier contractor in connection with a U.S. government contract shall be made
only upon their prior written agreement to terms required by Hewlett-
Packard.

Sublicensing and Distribution

•  Customer may not sublicense the software or distribute copies or
adaptations of the software to the public in physical media or by
telecommunication without the prior written consent of Hewlett-Packard.

Termination

•  Hewlett-Packard may terminate this software license for failure to comply
with any of these terms provided Hewlett-Packard has requested Customer
to cure the failure and Customer has failed to do so within thirty (30) days
of such notice.
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Updates and Upgrades

•  Customer agrees that the software does not include future updates and
upgrades which may be available from Hewlett-Packard under a separate
support agreement.

Export

•  Customer agrees not to export or re-export the software or any copy or
adaptation in violation of the U.S. Export Administration regulations or
other applicable regulations.

Limited Warranty

Software

Hewlett-Packard warrants for a period of one year from the date of purchase
that the software product will execute its programming instructions when
properly installed on the instrument indicated on this package.  Hewlett-
Packard does not warrant that the operation of the software will be
uninterrupted or error free.  In the event that this software product fails to
execute its programming instructions during the warranty period, Customer's
remedy shall be to return the media to Hewlett-Packard for replacement.
Should Hewlett-Packard be unable to replace the media within a reasonable
amount of time, Customer's alternate remedy shall be a refund of the purchase
price upon return of the product and all copies.

Media

Hewlett-Packard warrants the media upon which this product is recorded to be
free from defects in materials and workmanship under normal use for a period
of one year from, the date of purchase.  In the event any media prove to be
defective during the warranty period, Customer's remedy shall be to return the
media to Hewlett-Packard for replacement.  Should Hewlett-Packard be unable
to replace the media within a reasonable amount of time, Customer's alternate
remedy shall be a refund of the purchase price upon return of the product and
all copies.

Notice of Warranty Claims

Customer must notify Hewlett-Packard in writing of any warranty claim not
later than thirty (30) days after the expiration of the warranty period.
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Limitation of Warranty

Hewlett-Packard makes no other express warranty, whether written or oral, with
respect to this product.  Any implied warranty of merchantability or fitness is
limited to the one year duration of this written warranty.

This warranty gives specific legal rights, and Customer may also have other
rights which vary from state to state, or province to province.

Exclusive Remedies

The remedies provided above are Customer's sole and exclusive remedies.  In
no event shall Hewlett-Packard be liable for any direct, indirect, special,
incidental, or consequential damages (including lost profit) whether based on
warranty, contract, tort, or any other legal theory.

Warranty Service

Warranty service may be obtained from the nearest Hewlett-Packard sales
office or other location indicated in the owner's manual or service booklet.
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Chapter 1  

Getting Started

This chapter provides instructions for installing the HP 85878A EMI report
generator software and describes the application interface. Use this chapter to
familiarize yourself with the overall application, then use the subsequent
chapters to learn how to perform the tasks of capturing measurement data and
creating reports.

Topics in this chapter include:

•  What You Received with Your HP 85878A Software

•  Hardware Supported

•  Personal Computer Requirements

•  Preparing for Use

•  Installing the Hardware Key

•  Installing the HP 85878A Software

•  Running the Application for the First Time

•  HP 85878A Product Description

•  HP 85878A Main Window Features

Note  To take full advantage of this product, you should be familiar with
performing EMI measurements and using the Hewlett-Packard equipment
supported by the HP 85878A software. For further information on these topics,
see the Product Note 8590EM-1, Electromagnetic Compatibility, included with
this software package.  The product note describes how the equipment fits into
the EMI measurement process. For more detailed information about performing
measurements using HP equipment, check the appropriate documentation for
those products.
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What You Received with Your HP 85878A Software

If you are missing any of the following items, notify your local Hewlett-Packard
sales office or representative.

Standard Product

•  Six disks containing the HP 85878A software

•  Hardware key

•  HP 85878A User’s Guide

•  Product Note 8590EM-1, Electromagnetic Compatibility

Option 001

•  Microsoft Word for Windows 7.0

Option 488

•  National Instruments AT-GPIB/TNT(PnP) interface card
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Hardware Supported

The following hardware is supported by the EMI report generator software:

EMC Analyzers EMI Receivers EMI Receiver Systems

HP 8591EM HP 85422E HP 8542E

HP 8593EM HP 85462A HP 8546A

HP 8594EM HP 84100EM

HP 8595EM HP 84110EM

HP 8596EM HP 84125A

HP 84125B
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Personal Computer Requirements

The following describes the minimum and recommended requirements of
personal computer configurations. If the minimum requirements are not met, the
HP 85878A may not operate correctly.

Minimum PC Requirements

Computer 100% IBM-PC compatible

CPU 486/50

RAM 12 MB

Parallel Port Hardware key must be installed on LPT1

Graphics VGA 14-inch monitor with any Windows-supported
video board

Hard Disk 12 MB free disk space
25 MB free work environment

Floppy Disk 3.5 inch, 1.44 MB

GPIB National Instruments Corporation’s AT-GPIB or    AT-
GPIB/TNT(PnP) interface card

or HP-IB HP 82341C interface card

or RS-232 RS-232 serial interface (COM port)

Pointing Device Any mouse or trackball
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Recommended PC Requirements

CPU 486/50 or better

RAM 16 MB

Parallel Port Hardware key must be installed on LPT1

Graphics SVGA 17-inch monitor with graphics accelerator

Hard Disk 12 MB free disk space
75 MB free work environment

Floppy Disk 3.5 inch, 1.44 MB

GPIB National Instruments Corporation’s AT-GPIB or    AT-
GPIB/TNT(PnP) interface card

or HP-IB HP 82341C interface card

or RS-232 RS-232 serial interface (COM port)

Pointing Device Any mouse or trackball
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Preparing for Use

Before the HP 85878A software can run on your computer, the following
hardware and software must be installed first:

•  Microsoft Windows 95 operating system

•  Microsoft Word for Windows, version 7.0a (highly recommended)

•  RS-232 Serial Interface (COM port)

•  or National Instruments Corporation’s AT-GPIB or AT-GPIB/TNT(PnP)
interface card with associated driver software

•  or HP 82341C (HP-IB) interface card and associated driver software

Note  If using the  RS-232 serial interface, install the HP 85878A application
first in order to access the HP 85878A Serial Config utility to configure this
interface.

Instructions for installing the interface boards and the driver software is
contained in Appendix A, “Hardware Interface Installations.”
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Installing the Hardware Key

A hardware key is included with the HP 85878A software. This hardware key
must be installed on the first parallel port (LPT1) of the computer in order to
acquire data from the receiver. However, the hardware key is not required if
you are only editing data files previously created or creating a report; this
allows you to capture data using one computer and produce a report using
another computer. Up to five hardware keys may be cascaded on the parallel
port of the computer to run multiple software packages on the computer.

The hardware key is not specific to any individual computer. Therefore, it can
be moved to another computer at any time. For example, if the original
computer must be repaired, the software and hardware key may be loaded onto
another computer.
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Installing the HP 85878A Software

It takes only a few minutes to install the HP 85878A software. The Install
program in the HP 85878A software makes the installation easy.

1. Insert disk 1 of the HP 85878A software into the floppy drive then click on
the Windows 95 Start button.

2. Click on Run..., enter the letter of your floppy drive followed by the word
“setup,” then click the OK button. For example, if your floppy drive is
“A,” you will enter A:\setup.

3. A Welcome screen will appear. Click OK to continue the installation.

4. The destination directory screen appears with a default drive and directory
specified. If you do not want to use this destination, you must specify a
different location at this time for the Hp85878A directory to be created.
After you have specified the destination, click OK.

5. To complete your setup, follow the instructions on your screen.

Quick Tour Demonstration

Upon completion of the HP 85878A software installation, you will be prompted
to take a five-minute Quick Tour. This Quick Tour will provide you with a
brief overview on how to use this application to “capture” your measurement
data and create a report. You can also run the Quick Tour at any time by
choosing Help, Quick Tour from the main menu.
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Running the Application for the First Time

Follow these basic steps to open the HP 85878A application for the first time.

1. The first time you run the HP 85878A software, a default file named
“untitled.mdb” is opened. At this time, you may either choose a new file
with a more meaningful name via File, New or continue using this file and
rename it later. (Remember, a file is required to store your captured data
sessions.)

 It should be noted that subsequent executions of the HP 85878A software
will use the file that was in use when the application was last exited. That
is, the file to which data sessions are stored will always stay the same
unless you specify a new file via the File, New menu.

2. The Configure dialog box will appear enabling you to configure the I/O bus
by selecting one of the three interfaces which connect the computer to the
measuring receiver. The default set during installation is: GPIB, select code
of 0, and bus address of 18. Do one of the following:

•  Choose OK to use the default I/O bus setting.

•  Choose Cancel to close the HP 85878A application in order to set
up and configure your hardware interface. Refer to Appendix A,
“Hardware Interface Installations,” for more information on how to
install and configure the three different types of interfaces.

For information regarding the View tab, refer to “Changing the Header and
Session Pane Display” in Chapter 5.

Important!

After installing the HP 85878A software, make sure you have the correct
hardware configuration on your system. Use Help, Service, TestBus to test
your current configuration if you have any doubt about your setup.
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The three I/O buses available are:

•  RS-232 (COM port) requires the use of port number COM1, COM2,
COM3, or COM4 and a baud rate of 4800, 9600, 14400, or 19200.

•  HPIB (HP 82341C I/O card) requires the following two addresses be
specified: remote address between 0 and 30 and controller board address
between 0 and 7.

•  GPIB ( National Instruments AT-GPIB I/O card) requires the following two
addresses be specified: remote address between 0 and 30 and controller
board address between 0 and 7.

The Defaults button resets the values back to the installation values.

Uninstalling the HP 85878A Software

1. Click on the Windows 95 Start button.

2. Select Programs, HP EMI, then HP 85878A Uninstall. The Confirm
Uninstall message will appear. You will see a display box which lists the
HP 85878A filenames as they are listed in a log file. When this is
complete, a message is displayed that the software is uninstalled.
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HP 85878A Product Description

The HP 85878A EMI report generator software provides report generation and
archival of data for EMI applications. The report generator allows you to:

•  Transfer data from your instrument to your computer

•  Generate reports using the data you collected

•  Archive the data on your personal computer

The HP 8590EM Series and the HP 8540A/E Series have a built-in EMI
measurement engine which allows you to easily complete compliance or
precompliance EMI measurements. Use your equipment to make those
measurements and then archive and report your results using the HP 85878A
EMI report generator. With the report generator software, you can integrate
your test session results into a standard Windows 95 desktop interface.
Microsoft Word for Windows is used to generate standard reports. You can
archive your data in a relational database, allowing you to maintain your data
using Microsoft Access 7.0.

The HP 85878A application is composed of a single main window with two
panes: the header pane and session pane. The session pane is a tabbed
interface, where each tab represents a session, and the tab whose contents are
currently visible represents the “active session.” When a tab is selected, the
associated header data for that tab appears in the header pane. Each tab
contains data from a single test session and is labeled with a field from the
header pane. The tabs are ordered left to right with the leftmost tab being the
newest data and the rightmost is the oldest.

Data in the session pane consists of 2 or more (up to 12 total) data items
represented as icons. The 12 kinds of data items are: header (session) data,
screen capture, signal list, linear plot, log plot, trace A/B/C data, instrument
settings, correction factors, limit lines, and annotation. Data for each item is
collected from an attached measuring receiver when File, Get Data is selected
from the menu; the Get Data dialog box allows you to specify which of the 11
data items you wish to capture. Besides using the data items captured in the
automated report generator (using File, Create Report), the icons can be
dragged and dropped into Word for Windows and other Windows applications
which support OLE (object linking and embedding) formats.
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HP 85878A Functionality

The primary function of the HP 85878A software is to capture test session data
AFTER the measurements are performed by an instrument. The HP 85878A
software fits into your test environment as a tool for taking a snapshot of what
was measured by the analyzer or receiver. There is no direct contact between
the HP 85878A software and the equipment under test. In addition, there is no
way for the HP 85878A software to pass data back into a receiver or analyzer.
All communication is one way.

You can think of your computer running the HP 85878A software as a kind of
stop-motion camera for recording what is happening in your test environment. In
your daily work, you can schedule a large number of tests. Each test may be
unique, with its own instrument settings and conditions. After you perform each
test, you quickly “capture” the test data and save it into the computer
environment. Then you can reset your instrument and perform the next test,
knowing that you have captured everything you need to record about the
previous test. Each data capture is identified using date, time, and whatever
other information (that is, header data) you need to differentiate among the
various tests you have run.

Once you have the test information stored, you can sift through it and use it to
create printed reports, to compare results, or to document your work process.
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HP 85878A Main Window Features

When you start the HP 85878A application, you will see a single main window
with two panes—a header pane and session pane, a menu bar, and a toolbar.
The main window features are described in more detail in the sections which
follow.
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Header and Session Panes

The main HP 85878A window is divided into two panes. The upper pane is the
header pane and the lower pane is the session pane. The header pane consists
of multiple text fields corresponding directly to the fields of the active
session’s header data item. You may directly enter and modify information in
all fields except for Date/Time, Analyzer Model #, and Analyzer Serial #,
which are automatically generated by the application from the attached
receiver. If the current file contains no sessions, the header pane will initially
be empty but may be modified and will be copied into the next session that is
captured from the receiver. The order of the header pane fields can be
customized using Edit, Configure.

The purpose of the fields in the header pane is to allow you to identify and
keep track of test session data. Some examples of how you would use these
fields include:

•  Keeping track of the date and time a particular test was performed

•  Recording a particular setting used on the instrument

•  Making a report listing the tests that an operator performed on a given day

You do not have to use all the fields that appear in the header pane. Use those
that are most useful to you in tracking your test sessions. For example, the
header fields make it possible to specify search criteria for session data. You
can also use these fields to identify session data in order to perform merge and
delete operations. Chapter 6, ”Managing Files and Sessions,” contains more
information on these topics.

After capturing data, the session pane will contain icons representing the data
items collected in that test session. The tabs at the bottom of the session pane
display the date and time (of the receiver) when you used the HP 85878A
application to collect the session data from the instrument. Refer to the section
“Changing the Header and Session Pane Appearance” in Chapter 5 for detailed
information on rearranging the header fields and changing the tab label of the
session(s) from Date/Time.

The session pane shown below has the View, Header menu item unchecked.
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Main Menu Descriptions

The main menu items, listed below, are described in detail in the sections which
follow.

•  File

•  Edit

•  View

•  Window

•  Help
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File Menu

The File menu provides the following functions for the HP 85878A software:

New Creates a new file.

Open Opens an existing file.

Save Saves the header data.

Save As Saves a file using the file name or directory specified.

Print Setup Allows you to define specific printer properties.

Print Data Prints the data items as specified.

Get Data Captures data from the instrument.

Create Report Creates a new report in Microsoft Word.

Export Data Exports test data using the specified format.

Maintenance Repairs or compacts selected files.

Exit Exits the HP 85878A software.
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Edit Menu

The Edit menu provides the following functions for the HP 85878A software:

Undo Reverses the previous command. (Refer to the
section “Undo of a Delete” in Chapter 6 for more
detailed information.)

Cut Copies the data to the clipboard and removes the
data or data item.

Copy Copies the selected items or header data.

Paste Pastes the previously copied or cut data.

Clear Header Data Clears the data from the currently active header.

Delete Deletes a data item, session, or session group.

Find Session Finds the specified test session.

Merge Merges session group(s) from another file.

Configure Changes the I/O Bus configuration, specifies the
session tab label, and reorders the fields on the
header pane.



1-18 ••••  Getting Started

View Menu

The View menu provides the following functions for the HP 85878A software:

Toolbar Shows or hides the toolbar display.

Header Shows or hides the header pane.

Session Shows or hides the session pane.

Microsoft Word Opens up Microsoft Word.

First Session Sets the focus to the most recent session captured.

Previous Session Changes the focus to the session on the left.

Next Session Changes the focus to the session on the right.

Last Session Sets the focus to the first session captured.

By default, the toolbar, header pane, and session pane appear in the foreground
when the application is first started. Any changes which hide the toolbar,
header, or session panes are lost when exiting the application.



Getting Started ••••  1-19

Window Menu

The Window menu provides the following functions for the HP 85878A
software:

Cascade Displays all open data item windows in a cascaded style.

Show All Shows all open data item windows.

Close All Closes all the open data item windows.

<Data item> Lists the window names of the open data items.

The data item names corresponding to the currently opened windows are listed
in the order in which they were opened. For example, in the illustration above,
first the Signal List and then the Limit Lines windows were opened.
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Help Menu

The Help menu provides the following functions for the HP 85878A software:

Help Topics Lists the help topics available.

Quick Tour Provides an animated tour of key HP 85878A
features.

Service Lists service information and functions.

About HP 85878A Displays copyright information about the
HP 85878A application including the current
version number of the software and serial number,
if the hardware key is present.
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Toolbar Description

The toolbar provides the following functions for the HP 85878A software:

  New File

  Open File

  Save File

  Print Data

  Cut

  Copy

  Paste

  Get Data Again

  First Session

  Previous Session

  Next Session

  Last Session

  Find Session

  Clear Header

  Delete Session

  Merge

  Create Report

  Export Data

  Configure

  Microsoft Word

  Help

By positioning the cursor over each icon in the toolbar, descriptive text helps
you identify each function. You can also customize the toolbar by adding,
deleting, or reordering the icons. To access the Customize Toolbar dialog box,
simply double-click on any blank area next to a toolbar icon (for example, to
the right of the Help icon).
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The Customize Toolbar window allows you to add or remove icons, or to add
separators between icons. For example, the selection shown below will remove
the Word icon (from being displayed on the toolbar) when the user clicks the
Remove button.

You can cut down the number of icons that appear to suit your own
convenience. For example, if you find that in your work environment you only
use the Get Data Again and Microsoft Word icons, you could remove all the
icons except for these two.

The Move Up and Move Down buttons allow you to move icons or separators,
without deleting them. For example, the selection shown below has moved the
New icon down one position which in turn has moved the Open icon up one
position.
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You can also reposition an icon by clicking and holding down the left mouse
button then dragging it to the desired position. Likewise, you can move the
icons back and forth between the Available and Toolbar button list areas.

Add Adds the highlighted icon or separator to the displayed
toolbar.

Remove Removes the highlighted icon or separator from the
displayed toolbar.

Close Exits the dialog box after you have finished customizing.

Reset Resets the toolbar to the way it appeared before you made
changes.

Move Up Repositions the highlighted icon up by one position.

Move Down Repositions the highlighted icon down by one position.
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Chapter 2  

Acquiring Data from the Receiver

This chapter describes how to begin a test session and capture data from a
measuring receiver. Before capturing data, you must have installed the
hardware key, connected your computer to a receiver, and configured your
hardware interface. The steps described in this chapter assume that you already
have performed a measurement and have test data on the receiver; now you are
ready to use the HP 85878A software to capture that data.

The topics described in this chapter include:

•  Which Data Comes from the Receiver

•  Selecting Data Items

•  Capturing Data from the Receiver

For more information on viewing the data items you captured, refer to
Chapter 5, “Viewing Data.”
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Which Data Comes from the Receiver

All or part of each data item comes from the measuring receiver. All of the
following data items come entirely from the measuring receiver and cannot be
modified from the HP 85878A application:

•  Screen Capture

•  Linear Plot

•  Log Plot

•  Trace A

•  Trace B

•  Trace C

•  Instrument Settings

•  Correction Factors

•  Limit Lines

The Annotation data item comes directly from the receiver but is fully editable
from the HP 85878A application. All of the Signal List data item, except the
Comments, comes from the receiver; the Comments can only be entered using
the HP 85878A application. The only header fields which come from the
receiver are: Date/Time, Analyzer Model Number, and Analyzer Serial
Number. These three fields are not editable by the user. All other header fields
are editable.

The file type of the HP 85878A application is compatible with Microsoft
Access 7.0. Therefore, if other data must be edited, it can readily be done
using MS Access.

When your receiver is in signal analysis mode, the only data items available
are:

•  Screen Capture

•  Trace A

•  Trace B

•  Trace C

•  Instrument Settings

When your receiver is in EMC analyzer mode, all data items are available.
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Selecting Data Items

To acquire data from the measuring receiver, select 1 or more of the 11
optional data items from the Get Data dialog box. Which items remain checked
depend upon which items were used in the last Get Data action; a red check
mark on the icon indicates that the data item is selected. Each item corresponds
to a unified piece of data that the measuring receiver generates. Any
combination of data items acquired at one time is called a test session.

The File, Get Data menu and the Get Data Again icon on the toolbar both
enable you to perform a data capture. However, the Get Data dialog box does
not always appear when the Get Data Again icon is selected; it only appears if
there are no data items currently selected in the dialog box. As long as the
hardware key is present and the interface hardware is configured properly
between the computer and receiver, the Get Data dialog box is always
available when selecting File, Get Data from the main menu; whereas the Get
Data Again icon is provided for quick access in performing data captures.

Note  If you have run Get Data previously and you want to capture the same
data items in the next test session, then use the Get Data Again icon to perform
your capture quickly. Using File, Get Data allows you to change or verify your
data item selection before performing the data capture.

Each of the 11 data items is represented by a distinctive icon. Header
information is also represented by the Session Header icon but is not available
for selection during data capture since the header information is automatically
saved with each session. Data for each item is collected from the attached
measuring receiver when Get Data is performed.
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To capture information for a data item

1. From the File menu, choose Get Data.

2. Check the data item(s) that you want to capture.

3. Choose the OK button.
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The table shown below helps you select which data items you want to capture.
For more information about the contents of each data item, see Chapter 5,
“Viewing Data.”

Data Item Description

Screen Capture An image of what appears on the screen of the measuring
receiver.

Signal list A table with the following columns that can be added,
removed, or reordered using Edit, Preferences:

•  Signal

•  Frequency

•  Peak Amp

•  QP Amp

•  Avg Amp

•  Limit Line 1

•  Limit Line 2

•  Corrections

•  Peak-Lim1

•  QP-Lim1

•  Avg-Lim1

•  Peak-Lim2

•  QP-Lim2

•  Avg-Lim2

•  Marked

•  Comments

•  Span

Linear plot An image of what appears on the screen of the measuring
receiver when it is plotting the signal list on a linear
frequency scale.

Log plot An image of what appears on the screen of the measuring
receiver when it is plotting the signal list on a log
frequency scale.

Trace A Consists of 401 frequency/amplitude pairs representing
the data stored in trace A of the measuring receiver.

Trace B Consists of 401 frequency/amplitude pairs representing
the data stored in trace B of the measuring receiver.

Trace C Consists of 401 frequency/amplitude pairs representing
the data stored in trace C of the measuring receiver.



2-6 •••• Acquiring Data from the Receiver

Data Item Description

Instrument settings Consists of the following fields, displayed in
spreadsheet format:

•  Start Frequency

•  Stop Frequency

•  IF BW

•  Average BW

•  Sweep Time

•  Attenuation

•   Reference Level

•  Amplitude Units

•  dB per Division

•  Frequency Scale

•  Video Average

•  Video Avg Num of
Sweeps

•  Input

Correction factors Classifies the correction factors and displays a table
consisting of:

•  Status (corrections on or off)

•  Points (number of)

•  Frequency and amplitude pairs

•  Type (Antenna, Cable, Other, and Amp Cor)

Limit lines Describes the limit lines consisting of:

•  Limit line number

•  Frequency and
amplitude pairs

•  Frequency Scale

•  Amplitude Scale

•  Segments

•  Margin Status

•  Margin value

•  Limit Line Status

(1 or 2)

(on or off)

(on or off)

Annotation Consists of ASCII text typed into the measuring receiver
from the receiver’s plug-in keyboard, or is fully editable
from the HP 85878A application as a single text field.
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Capturing Data from the Receiver

Note  The hardware key must be installed on the first parallel port (LPT1) of
the computer in order to acquire data from the receiver. The Get Data function
is not available if any of the following is true: the key is missing, the key is not
the right one, or the receiver is not communicating.

The transfer of data from the receiver into the HP 85878A application only
occurs after data items have been selected and the OK button is clicked in the
Get Data dialog box, or when the Get Data Again icon is selected from the
toolbar (assuming that data items have been previously specified with the last
capture). The data transfer process cannot be interrupted and may take from a
few seconds to a few minutes. During the transfer, the hourglass cursor
appears.

After the transfer is complete, since it is the most recent data, a new tab is
created as the left-most tab on the session pane. This new tab becomes the
active session, its header data is presented in the header pane, and the data
items selected in the Get Data dialog box are displayed in the session pane.

Note  Follow these guidelines to make sure you enter the correct header
information:

•  Any header field information you wish to add should be entered after the
capture is complete.

•  If you modify the header information for the active session before the
capture, the header information you added will appear as part of the
previous session’s header as well.

•  When Get Data runs, the program copies any existing user-entered header
information from the previous session. This allows you to carry over
information from one session to the next. If you do not want to carry over
the information, you can use Clear Header Data after the Get Data
operation is complete.

Test session tabs are labeled using the date and time of the receiver when the
data is captured. You may also choose to change how these tabs appear using
Edit, Configure; this option is explained in more detail in Chapter 5, “Viewing
Data.”



2-8 •••• Acquiring Data from the Receiver

When the data transfer is complete, the test session is automatically saved in
the currently open file.

After you have run the Get Data command, you can open individual data items
in the current session by clicking the mouse on the associated icon. When you
double-click these individual icons, they open into their own windows.
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Test Session Example

Before trying this test session example, you must have configured your
hardware interface, connected your computer to an analyzer or receiver, and
installed the hardware key. Your receiver should contain information of interest
from the equipment under test, such as a signal list.

To add sessions to the sample.mdb file, follow the steps outlined below:

1. From the main menu, select File, Open then open the file sample.mdb
provided in the Hp85878A directory.

 Notice that there are two test sessions available. Select each tab and
observe the icons on the associated session pane.

2. From the main menu, select File, Get Data.

3. In the Get Data dialog box, check all of the data items displayed by
clicking on them.

 Note the red check mark that appears when you select an icon.

4. Choose OK to begin the data transfer from the receiver.

5. When the data transfer is complete, you are automatically returned to the
main window and the newly created session is now the active session.

6. From the main menu, select File, Get Data again and check only the Signal
List data item by clicking on it.

7. Choose OK to begin the data transfer from the receiver.

 When the data transfer is complete, notice that now you have a second new
tab. The second tab from the left is from your first session, where you
selected all the data items. The left-most tab is from your most recent
session, where you selected only the signal list.

8. Review the header information and edit any field(s), if necessary.

After you have made changes to the header fields, the changes are saved
when you change to another text field, switch to another session tab, or
change the focus to another area.
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Chapter 3  

Creating and Editing Reports

The HP 85878A application allows you to create reports based on the data you
have collected from test sessions. Reports can be created manually using any
word processor or spreadsheet you desire. The HP 85878A application also
has the ability to automatically create reports in Microsoft Word for Windows
with templates, using the Create Report selection from the File menu.

This chapter describes how to create an MS Word report using the data you
have acquired from the receiver. Topics covered in this chapter include:

•  Creating a Report Manually

◊ Drag-and-Drop Editing

◊ Copy and Paste Editing

•  Creating a Template-Based Report

◊ Create Report Window

•  Editing Reports

•  Creating Your Own Report Template

◊ Bookmark Format for HP 85878A Reports

◊ EMI Data Item Names

◊ Template Creation

◊ EMI Template Bookmarks
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Creating a Report Manually

A report can be created manually using any word processor, however, the
HP 85878A application has been designed to work with MS Word. Data
acquired by the HP 85878A application can be added to a report by two
methods: drag-and-drop editing for OLE compatible applications or copying
and pasting data items for Windows applications. Using either of these two
methods enables you to build a report as desired.

Drag-and-Drop Editing

Note  The drag-and-drop method is only available with applications that
support the object linking and embedding (OLE) format, for example, MS Word
7.0a or greater.

Drag-and-drop allows you to select a data item icon in the HP 85878A
application and copy it into an MS Word report quickly and easily with just the
use of the mouse.

To drag and drop a data item into a report

The following two methods of drag-and-drop are for use with MS Word 7.0a
and greater.

Method 1

1. Select the data item you want to move by clicking and holding down the
left mouse button on its icon.

2. As you move the cursor, a copy of the data item icon appears (as long as
you remain over the HP 85878A application).

3. With the mouse button still held down, drag the icon over an MS Word
document and note that the icon now becomes a cursor with a plus and a
dotted insertion point

4. Position the dotted insertion point at the location where you want to place
the data item contents, then release the mouse button.

5. The data item contents now appear in the MS Word 7.0a document.
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Method 2

An alternative method for using drag and drop is from an open data item
window.

1. Do one of the following to open a data item window:

•  Double-click on the data item you want to move.

•  Click the right mouse button on the data item you want to move then
select Open.

2. Do one of the following to select the data item contents.

•  For graphical data items, click on the image holding down the mouse
button.

•  For textual data items, click on the border area around the table (as
shown below) holding down the mouse button.

3. With the mouse button still held down, drag the icon over an MS Word
document and note that the icon now becomes a cursor with a plus and a
dotted insertion point

4. Position the dotted insertion point at the location where you want to place
the data item contents, then release the mouse button.

5. The data item contents now appear in the MS Word document.
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Drag-and-Drop Exception

To use drag and drop on the graphical data items with MS Word 6.0 or 7.0,
follow the same steps listed above. However, once you have dropped the
selected item into the Word 6.0 or 7.0 document, the following two steps
should be performed to ensure that the graphical data is saved as part of the
MS Word document.

1. In MS Word, double-click on the graphic. MS Word opens a separate
window (containing the graphic) in picture editing mode.

2. Click the Close Picture button to exit the picture editing mode.
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Copy and Paste Editing

The copy and paste editing method can be used for all Windows applications.

To copy and paste data item contents into a report

1. In the HP 85878A application, highlight the desired data item then do one
of the following:

•  From the main menu, choose Edit, Copy.

•  Position the cursor over the data item and click the right mouse button,
then choose Copy.

•  Click on the data item to highlight it, then press Ctrl-C on the
keyboard.

2. In the document, locate the position where you want to place the data item
contents.

3. In the document, do one of the following:

•  From the main menu, choose Edit, Paste.

•  Press Ctrl-V on the keyboard.
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Creating a Template-Based Report

Note  During the HP 85878A application installation, the install program
searches for the directory where MS Word is located. The sequence of the
directory search path is first MSOffice\Templates then Winword\Templates;
whichever is encountered first is where the EMI Temp subdirectory is created
and the HP 85878A report templates are copied into. If you do not have
MSOffice or MS Word installed on your system, the install program will copy
the HP 85878A report templates into the application directory under the
Template subdirectory.

Report templates have been provided with the HP 85878A application as
typical examples of EMI reports. These are MS Word document template files
(*.DOT) which contain EMI data item bookmarks; the bookmarks support auto-
insertion of data from one or more test sessions into the report. A new
document created from one of these templates will contain text and data which
serve as examples of what a report should look like. This example can be used
as a building block for creating your own report in which you have the full text
processing capabilities of MS Word.

Template-based reports may be created in two ways: from MS Word directly
or from the HP 85878A application main menu File, Create Report.

To start a new document from an EMI template

1. From the File menu in MS Word, choose New.

2. In the New dialog box, select the EMI Temp tab.

3. To create a new report from an existing EMI template, click on one of the
four EMI templates, and then choose the OK button.

4. MS Word gives the new document a temporary name, such as Document2,
until you save it with a unique filename.

5. Use MS Word functions and any other editing functions (for example,
drag-and-drop editing) to complete your report.
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To create a new report document automatically

1. From the File menu in the HP 85878A application, choose Create Report.

2. In the Create Report dialog box, click the Select button.

3. The Select EMI Report Template dialog box will display the four available
EMI templates and any other templates that you may have created.

4. Click on one of the EMI Templates then choose the Open button.

5. In the Create Report dialog box, highlight the test session data you wish to
use by clicking on the Actual Session drop-down list box and making your
selection.

6. If you wish to be prompted prior to inserting each piece of data, check the
Prompt Before Each Insertion checkbox.

7. Choose the OK button to perform an automatic report generation.



3-8 ••••  Creating and Editing Reports

Create Report Window

The Create Report window is accessed through the File menu in the
HP 85878A application. This command allows you to select a template for a
new report and then automatically opens MS Word (if it is not already open)
and creates a new document based on the selected template. If the template
contains one or more EMI data item bookmarks, session data is “auto-inserted”
into the MS Word report document by the HP 85878A application when OK is
selected.

The following four sections describe each of the areas contained in the Create
Report window:

•  Template Selection

•  Actual Session Selection

•  Session Identifier and Data Item To Insert Fields

•  Prompt Before Each Insertion
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Template Selection

Within the Create Report window, the default template name field appears at
the top of the dialog box. At this time you may select one of four templates
provided with the HP 85878A application or any template you may have
created. Click on the Select button to open the Select EMI Report Template
dialog box, make your selection, then choose the Open button. For more
information on how to create your own EMI report templates, refer to the
section “Creating Your Own EMI Report Template” later in this chapter.

The four EMI report templates included with the HP 85878A application are:

PRECOMP1.DOT Single session pre-compliant report,
Radiated

PRECOMP2.DOT Two session pre-compliant report,
Radiated and Conducted

COMP-FCC.DOT Two session FCC compliant report,
Radiated and Conducted

COMP-EN.DOT Four session European Norms compliant report,
CISPR Radiated and Conducted, and
FCC Radiated and Conducted
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Actual Session Selection

The Actual Session field displays all of the sessions in the current file. For
example, the sample.mdb file shown below contains two test sessions captured
on 11/14/96. The Actual Session displayed in both cases of the Radiated and
Conducted Session Identifier is the session captured most recently which is the
one with a time stamp of 11:42:10 AM. The actual session with the time stamp
of 11:42:10 AM is the Radiated session captured; the session with the time
stamp of 11:30:57 AM is the Conducted session, which is shown as being
selected as the appropriate session to match the Session Identifier.

The Session Identifier field is set by what has been defined in the selected EMI
template. In this case, PRECOMP2.dot contains two sessions: Radiated and
Conducted. To review the relationship between the selected EMI template and
the Session Identifier bookmarks, switch to MS Word and choose Edit,
Bookmark from the main menu. The Bookmark dialog displays all of the
bookmarks used to create the PRECOMP2.dot template; note that Conducted
and Radiated descriptions are in the position of <Session ID> as defined by the
EMI template format.

EMI_<Session ID>_<DataItemName>_#

EMI_Conducted_<DataItemName>_1

EMI_Radiated_<DataItemName>_1
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The Find button functions in conjunction with the Actual Session field in that it
helps you limit the number of test sessions you need to work with in creating
your report. When you have many test sessions in a file, the Find Session
Group dialog box enables you to choose sessions based on specific criteria or
you can review each session by the header information provided in the list area
at the bottom of the dialog box. After making your selection of test sessions,
choose the Select button and only these “selected” test sessions will remain in
the Actual Session drop-down list box.

Find Locates only the test sessions in the specified file which
match the search criteria and places those sessions in the
Sessions Found list.

Find All Places all of the test sessions in the specified file in the
Sessions Found list.

Select Chooses only the highlighted test sessions to retain in the
Actual Session drop-down list box (positioning them in
date/time order). All other test sessions are removed
from the list and the Find Session Group dialog box is
closed.

Cancel Closes the Find Session Group dialog box.

Clear Entries Clears all entries from the Search Criteria fields, leaving
them blank.
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Session Identifier and Data Item to Insert Fields

The Session Identifier and Data Item To Insert fields at the bottom of the
Create Report window display the bookmarks used in the selected EMI
template for each type of test. It should be noted that this Session Identifier
field corresponds directly to the Session Identifier field in the middle of the
dialog box. As you scroll through the list of Data Item To Insert fields, note
that these are the same fields as defined in the Bookmark dialog box in the MS
Word document.

Prompt Before Each Insertion

The Prompt Before Each Insertion checkbox allows you to be prompted prior to
the insertion of data, if checked, or leave unchecked if you want to fully utilize
the auto-insertion report process. This feature can be useful when you are
developing your own templates.
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Editing Reports

When your report is created in MS Word for Windows, it is a Word document
with a .DOC extension. You may open, close, save, or print this document in
the same way you work with any Word document. Data within this document
may now be edited using the standard Word commands. You may use Cut and
Paste between the HP 85878A application and MS Word. This allows you to
add items to your report in addition to those automatically inserted using
Create Report.

You may give your report document any name you choose. Remember to use
the .DOC extension, since it is now a document file rather than a template file.
In MS Word, the EMI Report menu item is added.

Report Example

The following report example is based on the sample.mdb file provided with
the HP 85878A application.

1. From the HP 85878A main menu, choose File, Open then select
sample.mdb and click the Open button.

2. From the File menu, choose Create Report.

3. In the Create Report dialog box, choose the Select button, highlight
PRECOMP2.dot as the report template, and then click the Open button.

4. For the Conducted Session Identifier, click on the Actual Session drop-
down list box and highlight the test session 11/14/96 11:30:57 AM.

 The Radiated and Conducted test session bookmarks predefined for the
PRECOMP2.dot EMI template are displayed in the Session Identifier and
Data Item To Insert fields at the bottom of the Create Report dialog box.

5. If you want a Prompt Before Each Insertion, click on the checkbox.

6. Click OK to start the report generation.

The report you created from the sample.mdb file should resemble the one
that appears below:
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Creating Your Own Report Template

If your work site already has a predefined EMI report format, you may want to
adapt your format into a report template. The automatic bookmarking feature in
MS Word is what enables the automatic insertion of test session data into
MS Word reports.

The tools described in the following sections have been provided so that
template creation is simplified.

•  Bookmark Format for HP 85878A Reports

•  EMI Data Item Names

•  Template Creation

•  EMI Template Bookmarks

Bookmark Format for HP 85878A Reports

In an HP 85878A report, the bookmark format appears as:

EMI_<Session ID>_<DataItemName>_#

In general, each bookmark includes four components separated by three
underlines. The first component is always “EMI” to indicate that it is an EMI
bookmark. The second component is the session identifier. This is user-
configurable to distinguish between different test data acquisition sessions; for
information on how to create a session identifier, refer to the section “To add
bookmarks to your template” later in this chapter. The third component is a
description of individual EMI measurements that can be acquired from various
HP EMI receivers, which is described in the next section “EMI Data Item
Names.” The fourth component is an integer ranging from 1 to 99 so that an
EMI measurement can be inserted at different places in a report.
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EMI Data Item Names

This section describes possible EMI data item names that can be inserted as the
third bookmark component. Unless indicated by an asterisk (*) which means
data inserted by user, these data items are obtained from EMI receivers.

Third Bookmark Component Description

Annots Annotations

InstrSettings Instrument settings

LinearPlot Linear plot

LogPlot Log plot

ScreenCapture Screen capture

SignalList Signal list

TraceA Trace A

TraceB Trace B

TraceC Trace C

CorrFactors All correction factors

CorrFactorAnt Antenna correction factor

CorrFactorCab Cable correction factor

CorrFactorUsr Amp Cor correction

CorrFactorOthr Other correction factor

LimitLines All limit lines

LimitLine1 Limit line 1

LimitLine2 Limit line 2

Header All header data

Title Title of the current EMI report

DateTime Date/Time the EMI data are captured

JobNum Job number *

TestName Name of the current test *

EUTName Equipment under test’s name *
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Third Bookmark Component Description

EUTModelNum Equipment under test’s model number *

EUTSerNum Equipment under test’s serial *

AnalyzerModNum Analyzer model number

AnalyzerSerNum Analyzer serial number

SiteDescrpt Test site description *

OperatorName Operator name *

TestCompName Test company name *

TestCompAddr Test company address *

TestCompFax Test company fax number *

TestCompEmail Test company Email address *

CustomerName Customer name *

CustomerAddr Customer address *

CustomerPhone Customer phone *

CustomerFax Customer fax number *

CustomerEmail Customer Email number *

Notes Notes *
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Template Creation

The following four procedures describe the process for creating your own
template:

To prepare a document for bookmarks

1. In MS Word, from the File menu, choose New.

2. In the New dialog box, select the EMITemp tab and highlight a template
that is similar to what you want.

3. Choose the Template option from the Create New area then click OK.

 At the end of this step, the desired Microsoft Word document is opened
and available for bookmark insertion.

To add the EMI Report menu to MS Word

A Microsoft Word macro named rptmacrs.dot is provided to facilitate the EMI
bookmark creation. It resides in the HP 85878A executable directory. When
active, this macro adds the EMI Report menu to the main menu bar. If this
menu item is not visible, activate it using the following steps:

1. In MS Word, from the File menu, choose Templates.

2. Do one of the following:

•  If the rptmacrs.dot is available in the Global Templates and
Add-ins box, check its box and then click OK.

•  The EMI Report should now be visible on the main menu bar.

•  In the Global Templates and Add-ins box, choose the Add button, then
use the Add Template dialog box to add the rptmacrs.dot in the
HP 85878A executable directory.
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To add bookmarks to your template

1. Place the cursor at a desired location for a bookmark.

2. From the EMI Report menu, choose Insert Data Item Bookmark.
The Insert Data Item Bookmark dialog box will appear.

3. In the Session Identifier area, choose either the Sequential or Custom
session option. If the Custom option is selected, the second bookmark
component must be explicitly defined in the associated text box.

4. In the Data Item box, select the desired data item to be inserted at this
bookmark.

5. Review the full bookmark entry displayed at the bottom of the window to
make sure that the desired item is selected then click OK.

6. Repeat steps 3 through 5 until all desired bookmarks are added.
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To save your new template

1. From the File menu, choose Save As.

2. In the File Name box, type a name for the new template.

3. In the Save In box, open the Templates folder in the folder in which you
installed MS Office or Word.

4. In the Save As Type box, select Document Template (*.dot).
Click the Save button to save your new template as another EMI template.

EMI Template Bookmarks

The bookmarks for the four EMI templates provided with the HP 85878A
application are listed below.

PRECOMP1.dot Bookmarks

EMI_Radiated_Annots_1 EMI_Radiated_Title_1

EMI_Radiated_EUTName_1 EMI_Radiated_EUTSerNum_1

EMI_Radiated_SiteDescrpt_1 EMI_Radiated_OperatorName_1

EMI_Radiated_TestName_1 EMI_Radiated_DateTime_1

EMI_Radiated_Notes_1 EMI_Radiated_LogPlot_1

EMI_Radiated_SignalList_1

PRECOMP2.dot Bookmarks

EMI_Conducted_Annots EMI_Conducted_LogPlot

EMI_Conducted_SignalList EMI_Radiated_Annots_1

EMI_Radiated_Title_1 EMI_Radiated_EUTName_1

EMI_Radiated_EUTSerNum_1 EMI_Radiated_SiteDescrpt_1

EMI_Radiated_OperatorName_1 EMI_Radiated_TestName_1

EMI_Radiated_DateTime_1 EMI_Radiated_Notes_1

EMI_Radiated_LogPlot_1 EMI_Radiated_SignalList_1
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COMP_FCC.dot Bookmarks

EMI_Conducted_CorrFators_1 EMI_Conducted_CustomerAddr_1

EMI_Conducted_CustomerEmail_1 EMI_Conducted_CustomerFax_1

EMI_Conducted_CustomerName_1 EMI_Conducted_CustomerName_2

EMI_Conducted_CustomerName_3 EMI_Conducted_CustomerName_4

EMI_Conducted_CustomerPhone_1 EMI_Conducted_EUTName_1

EMI_Conducted_OperatorName_1 EMI_Conducted_SignalList_1

EMI_Conducted_TestCompAddr_1 EMI_Conducted_TestCompEmail_1

EMI_Conducted_TestCompFax_1 EMI_Conducted_TestCompName_1

EMI_Conducted_TestCompPhone_1 EMI_Radiated_CorrFactorAnt_1

EMI_Radiated_SignalList_1

COMP_EN.dot Bookmarks

EMI_ConductedCispr_CorrFactors_1 EMI_ConductedCispr_JobNum_1

EMI_ConductedCispr_ScreenCapture_1 EMI_ConductedCispr_SignalList_1

EMI_ConductedFcc_CorrFactors_1 EMI_ConductedFcc_CustomerAddr_1

EMI_ConductedFcc_CustomerName_1 EMI_ConductedFcc_DateTime_1

EMI_ConductedFcc_EUTModelNum_1 EMI_ConductedFcc_JobNum_1

EMI_ConductedFcc_OperatorName_1 EMI_ConductedFcc_ScreenCapture_1

EMI_ConductedFcc_SignalList_1 EMI_RadiatedFcc_Title_2

EMI_RadiatedCispr_CorrFactors_1 EMI_RadiatedCispr_DateTime_1

EMI_RadiatedCispr_EUTName_1 EMI_RadiatedCispr_EUTSerNum_1

EMI_RadiatedCispr_JobNum_1 EMI_RadiatedCispr_LogPlot_1

EMI_RadiatedCispr_SignalList_1 EMI_RadiatedCispr_Title_1

EMI_RadiatedFcc_CorrFactors_1 EMI_RadiatedFcc_DateTime_1

EMI_RadiatedFcc_EUTName_1 EMI_RadiatedFcc_EUTSerNum_1

EMI_RadiatedFcc_JobNum_1 EMI_RadiatedFcc_JobNum_2

EMI_RadiatedFcc_LogPlot_1 EMI_RadiatedFcc_SignalList_1

EMI_RadiatedFcc_TestName_1 EMI_RadiatedFcc_Title_1
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Chapter 4  

Editing Data

There are three data items in which you can edit: all but three fields in the
header pane, the Comments field in the Signal List data item, and the text field
in the Annotation data item.

The topics described in this chapter include:

•  Header Information Editing

•  Comments Field (Signal List) Editing

•  Annotation Editing

To open and view the contents of data items, you can double-click on the icons
displayed in the session pane. For editing purposes in the Annotation and
Signal List data items, you can use the Cut, Copy, Paste, and Select All
commands from the Edit menu.
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Header Information Editing

All of the fields within the header pane can be edited, except for:

•  Date/Time

•  Analyzer Model Number

•  Analyzer Serial Number

These fields come entirely from the measuring receiver at the time of data
capture.

All remaining fields can be edited from within the header pane and may contain
up to 255 characters, except for the Notes field, which may contain up to 65536
characters. You can tab from one field to another, or use the scroll bars in the
header pane to see additional fields.

After you click on the field you wish to edit, you can perform edit operations
such as typing, deleting, or moving text. The Cut, Copy, and Paste commands
in the main Edit menu will work on the header fields. The Delete menu item is
for data items, sessions, and session groups, not for text. The Delete key on the
keyboard allows you to delete text from header fields, or Edit, Undo Typing
allows you to undo the most recent typing.
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After you have made changes to the header fields, the changes are saved when
changing to another text field, switching to another session tab, or changing the
focus to another area. Your changes are also saved automatically when you
perform a drag and drop operation.

All editable header fields may be cleared by using the Clear Header Data menu
item from the Edit menu. When selected, all the editable data in the currently
active header is erased. You can perform an Undo Clear Header Data as long
as you remain within the session where the Clear Header Data action was
performed; as soon as you change to another session, the undo buffer is
cleared.

It should be noted that the Session Header data item cannot be edited but only
displays header information that has been either captured with a test session or
edited through the header pane fields as described above. This data item has
been provided to enable you to easily copy and paste multiple parts of the
header information into other applications.
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Comments Field (Signal List) Editing

Only the Comments field of the Signal List data item is editable within its
window. Open the signal list window by double-clicking on the Signal List data
item icon. Position the cursor in the desired Comments field then double-click
to initiate the editing mode. You can now perform any text editing operation:
typing text, deleting text, cutting and pasting text, and so on. The Cut, Copy,
Paste, and Select All commands in the signal list Edit menu also will work on
the comments fields, as well as normal keyboard and mouse editing actions.

The maximum number of characters that can be contained in the comments field
is 255. The changes to the comments are automatically saved when you move
to another field.

For example, in the following illustration, the cursor is set in the comments field
in the first row of the signal list. In this example, the comments added are
“clock fundamental.”
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Annotation Editing

Open the Annotation window by double-clicking on the Annotation data item
icon. The Annotation window opens as an editable and scrollable text field.
You can perform any text editing operation: typing text, deleting text, cutting
and pasting text, and so on. The Cut, Copy, Paste, and Select All commands in
the Annotation Edit menu work in the annotation text field, as well as normal
keyboard and mouse editing actions.

The changes to the text are automatically saved when you close the window.
Changes are also saved when you perform a drag and drop operation.

For example, in the illustration below, the text added here in the Annotation
data item will appear in the Annotation area of the report.
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Chapter 5  

Viewing Data

After you have acquired data from the receiver, each of the data items you
selected may be accessed and viewed. This chapter describes how to display
the contents of each data item type. It also describes how to view header data
in two ways: through the header pane and through the header data item.

The topics explained in this chapter include:

•  Viewing the Header Pane

•  Changing the Header and Session Pane Display

•  Opening and Viewing Data Items

◊ Data Item Menus

◊ Screen Capture

◊ Signal List

◊ Correction Factors

◊ Limit Lines

◊ Annotation

◊ Session Header

◊ Linear Plot

◊ Log Plot

◊ Trace A, Trace B, and Trace C

◊ Instrument Settings
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Viewing the Header Pane

The header pane is the upper section of the HP 85878A main window
associated with a test session. Use the header pane fields to identify and keep
track of test session data; you do not have to use all the fields that appear in
the header pane.

The header is the only data item that you can view in two ways: in the header
pane and in the Session Header data item window found in the session pane.
The Session Header data item window is provided to give the user the ability to
easily copy and paste multiple parts of the header information into other
applications. You may also copy and paste individual fields one at a time from
the header pane itself.
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In the header pane, all fields are editable except for Date/Time, Analyzer
Model Number, and Analyzer Serial Number. The date and time is taken from
the receiver clock at the time of data capture. The Session Header data item
can only be viewed, it cannot be edited.

The header pane consists of the following fields:

•  Date/Time (of the Get Data)

•  Title

•  Job Number

•  Test Name

•  EUT Name

•  EUT Model Number

•  EUT Serial Number

•  Analyzer Model Number

•  Analyzer Serial Number

•  Site Description

•  Operator Name

•  Test Company Name

•  Test Company Address

•  Test Company Phone Number

•  Test Company Fax Number

•  Test Company Email

•  Customer Name

•  Customer Address

•  Customer Phone Number

•  Customer Fax Number

•  Customer Email

•  Notes
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Changing the Header and Session Pane

Appearance

You can change the header and session pane appearance by using the Edit,
Configure menu item. The View tab on this dialog box allows you to change the
session tab labels and order of fields in the header pane, in the current session.

If you scroll through the Session Tab Labels field, you can select the label that
will appear on your session pane tabs. For instance, you can select Test Name
as the session pane tab, instead of the Date/Time. This would then display the
test name you assigned on your session tabs, such as Radiated Emissions,
Conducted Emissions, and so on.
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If you scroll through the Header Fields display, you can choose to rearrange the
order of header fields. You can select one of the header fields, and move it up
or down the list, using the arrow buttons. The example below shows the field
Operator Name being moved up the list, to the spot immediately after the
Date/Time. If you find that certain header fields are used more often, you may
find this customization option helpful for you.
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Opening and Viewing Data Items

Test sessions consist of 2 to 12 individual data items. Each item is represented
in the session pane as an icon. When double-clicked, each data item opens up a
window for viewing. Clicking the right mouse button on a data item then
selecting Open also opens up a window for viewing. This section describes the
data item windows for:

•  Screen Capture

•  Signal List

•  Linear Plot

•  Log Plot

•  Trace A

•  Trace B

•  Trace C

•  Instrument Settings

•  Correction Factors

•  Limit Lines

•  Annotation

•  Session Header



Viewing Data ••••  5-7

Clicking the right mouse button brings up the following menu selections for all
of the data items except for Session Header:

Open Is the same as double-clicking the data item which opens up a
window for viewing its contents.

Print Brings up the Print dialog box which allows you the option of
specifying another printer and associated properties and the
number of copies you would like.

Export Brings up the Export dialog box which allows you the option
of specifying the destination directory, filename, and format
option of the data item being exported.

Cut Copies the entire data item to the Clipboard and removes it
from the current test session.

Copy Copies the entire data item to the Clipboard.

Delete Removes the entire data item from the current test session.

Session Header does not have the Cut and Delete menu items available.
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Data Item Menus

Each data item window has a File menu.

  File menu for all data items

Non-editable text item windows have an Edit menu of Copy and Select All.

  Edit menu for non-editable text data items

Non-editable graph item windows have an Edit menu of Copy only.

  Edit menu for non-editable graph data items

Editable item windows (that is, Annotation and Signal List only) have an Edit
menu of Cut, Copy, Paste, and Select All. The Edit menu for the Signal List
data item also has the Preferences menu which allows you to add, remove, or
reorder the column definitions.

  Edit Menu for Editable Data Items
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Screen Capture

The screen capture is an image of what appears on the screen of the measuring
receiver. This data item is not editable but can be resized.
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Signal List

The Signal List data item consists of a table as shown below:

You can resize the signal list, or adjust the width of the columns. Adjust the
column width by positioning your cursor in the column heading area between
two columns until the sizing arrows appear, then use these arrows to set the
desired width.

The scroll bars allow you to view the defined columns. For instance, to get the
displayed signal list below, you would scroll to the right to see the Comments
field.
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The signal list comments field is editable. The Edit menu for the signal list
contains the following selections:

The Edit, Preferences selection accesses the Signal List Column Definition
dialog box which enables you to add, remove, or reorder the columns. When
you highlight a column description in the Available Columns field, you can add
or append that column to the display by using the Add and Append buttons.
When you highlight a column in the Displayed Columns field, you can remove
or reposition that column by using the Remove button or up and down arrows.
When you are satisfied with the column arrangement, click Apply to set up the
new signal list order.
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Add Adds the highlighted column to the Displayed Columns list. If
a column is highlighted in the Displayed Columns list, then the
added column is positioned directly above it. If no column is
highlighted in the Displayed Columns list, then the added
column is positioned at the top of the list.

Remove Removes the highlighted column from the Displayed Columns
list. If a column is highlighted in the Available Columns list,
then the removed column is positioned directly above it. If no
column is highlighted in the Available Columns list, then the
removed column is positioned at the top of the list.

Append Adds the highlighted column to the bottom of the Displayed
Columns list.

Up/Down (Arrows) move the highlighted Displayed Column up or down
by one position with each click.

Cancel Exits the Signal List Column Definition dialog box without
performing any action.

Done Applies any column changes and exits the window.

Apply Applies any column changes without exiting the window.
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The signal list is sorted by the first column in the Displayed Columns field.
When the signal list data item window is initially opened, the following five
columns are displayed: signal (number), frequency (MHz), peak amplitude, QP
amplitude, and average amplitude. If the data item window is closed and
reopened, it retains its previous column configuration. No data can be edited by
the user except for the data in the Comments column.

The 17 signal list columns available are:

Signal Number representing the order of the signal when the data
was acquired

Freq Frequency of the signal (MHz)

Peak Amp Peak amplitude

QP Amp Quasi-peak amplitude

Avg Amp Average amplitude

LimitLine1 Amplitude value of limit line 1

LimitLine2 Amplitude value of limit line 2

Corrections Total amplitude of corrections applied to the signal (dB)

Peak - Lim1 Peak limit line 1 subtracted from the corrected peak
amplitude of the signal

QP - Lim1 Quasi-peak limit line 1 subtracted from the corrected quasi-
peak amplitude of the signal

Avg - Lim1 Average limit line 1 subtracted from the corrected average
amplitude of the signal

Peak - Lim2 Peak limit line 2 subtracted from the corrected peak
amplitude of the signal

QP - Lim2 Quasi-peak limit line 2 subtracted from the corrected quasi-
peak amplitude of the signal

Avg - Lim2 Average limit line 2 subtracted from the corrected average
amplitude of the signal

Marked User-defined flag

Span Frequency span of the receiver when the center frequency
was selected during an automated measurement

Comments Comment added by user, otherwise, field remains blank
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Linear Plot

The linear plot is an image of what appears on the screen of the measuring
receiver when it is plotting the signal list on a linear frequency scale. This data
item is not editable but can be resized.
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Log Plot

The log plot is an image of what appears on the screen of the measuring
receiver when it is plotting the signal list on a log frequency scale. This data
item is not editable but can be resized.



5-16 ••••  Viewing Data

Trace A, Trace B, and Trace C

Trace data in the HP 8590EM Series analyzers and the HP 8540A/E Series
receivers consists of 401 points of frequency and amplitude pairs. When in
linear frequency scale, the frequency points are evenly spaced between the start
and stop frequencies of the instrument. In log frequency scale, the frequency
numbers are logarithmically spaced. The trace data is displayed in the Trace A,
Trace B, and Trace C data item windows. (Trace A is shown below.) These
data items are not editable but can be resized. To adjust the column width,
move your cursor to the column heading area until the sizing arrows appear,
then use these arrows to set the desired width.
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Instrument Settings

The main instrument settings for the test sessions you are recording are the
ones the instrument was using at the time you captured data. These settings
match the data on the screen capture and on Trace A, Trace B, and Trace C.

The instrument setting information is displayed as shown below. This data item
is not editable but can be resized.

The instrument settings include:

•  Start frequency

•  Stop frequency

•  IF bandwidth

•  Average bandwidth

•  Sweep time

•  Attenuation

•  Reference level

•  Amplitude units

•  dB per division

•  Frequency scale

•  Video average status

•  Video average number
of sweeps

•  Input
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Correction Factors

The HP 8590EM Series analyzers and the HP 8540A/E Series receivers can
contain up to four independent sets of corrections factors designated as
Antenna, Cable, Other, and Amplitude Correction. The correction factors
consist of a description of the correction factor and a table of frequency-
amplitude points. The correction factors are displayed as shown below. This
data item is not editable but can be resized. To adjust the column width, move
your cursor to the column heading area until the sizing arrows appear, then use
these arrows to set the desired column width.

The correction factors include:

•  Status (corrections on or off)

•  Points (number of)

•  Frequency and amplitude pairs

•  Type (Antenna, Cable, Other, and Amp Cor)
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Limit Lines

There can be either 1 or 2 limit lines stored in the HP 8590EM Series analyzers
and the HP 8540A/E Series receivers while in EMI receiver mode. If available,
both the limit-line description and the limit-line segment table are displayed for
limits 1 and 2 as shown below. This data item is not editable but can be
resized. To adjust the column width, move your cursor to the column heading
until the sizing arrows appear. You can then use these arrows to change the
column width.

The limit line description reflects the settings used by the receiver at the time
of data acquisition.

•  Frequency Scale, linear or logarithmic

•  Amplitude Scale, linear or logarithmic

•  Segments, number of

•  Margin Status, on or off

•  Margin, value of

•  Limit Line Status, on or off
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Annotation

The annotation consists of ASCII text typed into the measuring receiver from
the receiver’s plug-in keyboard. This annotation is fully editable from the
HP 85878A software as a single text field. Although annotation in the
HP 8590EM Series analyzers and HP 8540A/E Series receivers are limited to
1024 characters, this text can be edited from the HP 85878A to a total of 8000
characters of text.
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Session Header

Session Header is the only data item that you can view in two ways: in the
header pane and in its data item window. The data item window allows you to
copy and paste parts of the header information into other applications.

You can only change the header data through the header pane. Within the
Session Header data item window, the fields are not editable. The window may
be resized.

The order in which the header data fields appear can be changed by the user.
The Edit, Configure menu item in the HP 85878A main window provides this
capability. Refer to the section on “Changing the Header and Session Pane
Appearance” at the beginning of this chapter for more information.
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Chapter 6  

Managing Files and Sessions

In your work environment, you may generate a number of test results. The
HP 85878A software allows you to save test results in a file consisting of
individual test sessions. It is up to you how you combine test sessions within a
file: one test session per file, or twenty test sessions per file. As hundreds of
test sessions are saved, you may find the speed of access to slow down. After
you have stored the test sessions, you can go back and search through the file
using the criteria you specify. You can then select and delete test sessions, or
select test sessions from other files to merge into the current file.

This chapter describes how to accomplish the following tasks from within the
HP 85878A software:

•  Creating New Files

•  Opening Files

•  Saving Files

◊ Saving Header Data

•  Finding Sessions

◊ Search Criteria

•  Merging Sessions

•  Deleting Data

◊ Item

◊ Session

◊ Session Group

◊ Header Data

◊ Undo a Delete

•  Maintaining Files

◊ Repairing a File

◊ Compacting a File
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Creating New Files

A new (empty) file can be created in which to capture new sessions or to save
previously captured sessions as a new group. (Refer to “Merging Sessions”
later in this chapter.) When a new file is created, it displays: blank header
fields, an unlabeled tab, and the new filename (with its full directory path in the
status bar at the bottom of the window).

To create a new file

1. Do one of the following:

•  On the toolbar, click the New icon.

•  From the File menu, choose New.

2. Select the directory from the Save in drop-down list box in which you want
to save the file.

3. Type a filename in the File Name box.

4. Choose the Save button.



Managing Files and Sessions •••• 6-3

Opening Files

A file previously created and saved may be opened at any time using File,
Open. The opened file now becomes the active and current file. When the
application is started, it automatically attempts to open the file that was open
when the application was last exited. If the previously opened file is
unavailable or no longer valid, you will be given the option of selecting a
different file to open.

To open an existing file

1. Do one of the following:

•  On the toolbar, click the Open icon.

•  From the File menu, choose Open.

2. In the list area, select the name of the file you want to open.

 If you do not see the file you want to open, select a new drive or directory
from the Look In drop-down list box.

3. Choose the Open button.
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Saving Files

All session data acquired from the Get Data operation is saved to the open file
immediately after the acquisition. Any edits done in a specific data item
window is saved when the window is closed. Any unsaved data, whether in a
data item window or the header pane, is saved when the application is exited
properly.

Therefore, the only time you would need to explicitly save a file would be
when creating a duplicate file using the File, Save As menu selection.

To save a new file

1. From the File menu, choose Save As.

2. Select the directory in which you want to save the file from the Save in
drop-down list.

3. Type a filename in the File Name box.

4. Choose the Save button.
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Saving Header Data

The File, Save menu selection (or Save icon in the toolbar) is for saving header
data only. When editing any of the header data fields, you can save the new
information by either selecting File, Save or selecting another session as the
active session.

To save header data

1. Make your changes to the header data fields.

2. Do one of the following:

•  On the toolbar, click the Save icon.

•  From the File menu, choose Save.
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Finding Sessions

The current file can be searched for specific information. To search for a
session, use either the Edit, Find Session menu item or the Find Session icon on
the toolbar. The Find Session dialog box will appear which allows you to fill in
certain fields which need to be matched. Entries in these fields can include text,
which will be matched precisely, and the wildcards: question mark (?), asterisk
(*), number sign (#), range of characters ([chars]), and outside a range of
characters ([!chars]). If multiple fields are used as search criteria, then the test
session must match all selected fields.

Find Locates only the test sessions in the current file which
match the search criteria.

Clear Entries Removes all entries from the Search Criteria fields,
leaving them blank.

To use the search function, choose a search criteria field and enter the
appropriate information for that field. Select the Find button to initiate the
search. The search begins from the active session to the right looking for a
match. If no match is found, there is no change in the application. If a match is
found, that session becomes the active session. Selecting the Find button again
performs the same search for the next session to the right which matches. The
search does not wrap around; that is, the search begins at the next session to the
right and continues until the end of the file is reached. In order to search the
beginning of the file, you must choose the first session to the farthest left and
perform the search again.
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Session Searching Example

The search function allows you to find a specific session in the current file. For
example, if you had been capturing test data into one file on a daily basis for a
month’s period of time and you wanted to review the data taken on the 15th day
of that month, you would use a procedure as follows:

1. Click on the first tabbed session on the far left in order to begin your
search from the most recent session. Remember, the search process moves
from left to right to the end of the file.

2. From the Edit menu, choose Find Session to access the Find Session dialog
box.

3. In the Date From box, enter in the 15th day of the month for which you are
searching in the format mm/dd/yy.

4. Click on the Find button to initiate the search.

5. The tabbed session with the 15th day of the month displayed on the label
will now become the active session.

6. Click on the Cancel button to close the Find Session dialog box.
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Search Criteria

The search criteria fields are:

•  Date

•  Title

•  Job Number

•  Test Name

•  EUT Name

•  EUT Model Number

•  EUT Serial Number

•  Operator Name

•  Site Description

•  Test Company Name

•  Customer Name

Conventions for entering in dates as search criteria are as follows:

•  Date must be formatted as either month, day, and year (mm/dd/yy) or
month and year (mm/yy)

•  Separators between numbers can only be either a forward slash (/) or a
blank space

Note  If only entering a “From” date as search criteria, the search starts from
that date and ends with the most recent date.

More complex searches may be done using wildcard characters and
expressions. The following is a list of the available wildcard characters and the
number of digits or strings they match:

Wildcard

Characters Matches in expression

       ? Any single character

       ∗ Zero or more characters

       # Any single digit (0 through 9)

   [chars] Any single character in chars

   [!chars] Any single character not in chars

You may use an expression that contains any combination of characters and
operators (that is, wildcard characters) to specify a search pattern. An
expression can be simple, such as j?b, which finds any three-letter word
beginning with “j” and ending with “b,” or it can be complex, with several parts
enclosed in parentheses, which are individually evaluated.
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The following table shows examples of test expressions for different patterns.

Kind of match Pattern Match (True) No match (False)

Multiple characters “a*a”

“*ab*”

“aa”, “aBa”,

“abc”, “AABB”,

“aBC”

“aZb”, “bac”

Special character “a[*]a” “a*a” “aaa”

Multiple characters “ab*” “abcdefg”, “abc” “cab”, “aab”

Single character “a?a” “aaa”, “a3a”, “aBa” “aBBBa”

Single digit “a#a” “a0a”, “a1a”, “a2a” “aaa”, “a10a”

Range of characters “[a-z]” “f”, “p”, “j” “2”, “&”

Outside a range “[!a-z]” “9”, “&”, “%” “b”, “a”

Not a digit “[!0-9]” “A”, “a”, “&”, “~” “0”, “1”, “9”

Combined “a[!b-m]” “An9”, “az0”, “abc”, “aj0”

To find a session

1. From the File menu, choose Find Session.

2. Choose a search criteria field and enter the appropriate information for
which you want to search on.

3. Choose the Find button.

4. When you finish searching for sessions, choose the Cancel button to close
the window.



6-10 ••••  Managing Files and Sessions

Merging Sessions

One or more test sessions from previously-created files in this application can
be merged into the open file. Selecting either the Edit, Merge menu item or the
Merge icon in the toolbar brings up the Merge Sessions dialog box. You can
then use the Browse button to identify a file in which to search for test sessions
of interest. After specifying the search criteria, push the Find button and any
matching sessions will appear in the Sessions Found list area.

Each session can be individually selected in the Sessions Found list and its
associated header will be displayed in the list box at the bottom of the Merge
Sessions dialog box. In order to merge a session or group of sessions from the
displayed list, the session(s) need to be highlighted using click, shift-click, or
control-click from the mouse. When the Merge button is selected, the sessions
are added to the open file sorted by date/time order, and the file is
automatically saved.

Browse Accesses the Open dialog box to specify the file in which
to merge sessions from.

Find Locates only the test sessions in the specified file which
match the search criteria and places those sessions in the
Sessions Found list.
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Find All Places all of the test sessions in the specified file in the
Sessions Found list.

Merge Performs the merge by copying the selected session(s) to
the open file (positioning them in date/time order).

Cancel Closes the Merge Sessions dialog box.

Clear Entries Clears all entries from the Search Criteria fields, leaving
them blank.

Merge Sessions Example

The merge function allows you to combine similar sessions from many different
files into one file. For example, if you wanted to compare radiated emissions
tests from different files and place these sessions in a file named “Radiated,”
you would use a procedure as follows:

1. Create a new file by choosing File, New then enter in the filename
Radiated and choose the Save button.

2. From the main menu, select Edit, Merge to open the Merge Sessions
dialog box.

3. Use the Browse button to select the file to be used in the Merge From
field.

4. Select the Test Name search criteria field and enter Radiated Emissions,
then choose the Find button. All sessions that match the test name
Radiated Emissions will be placed in the Sessions Found list area.

5. From the Sessions Found list area, select the desired radiated emissions
sessions to be placed into the Radiated file created in step 1 then choose
the Merge button to copy these sessions to the file.

6. Use the Browse button again to select the next file, then simply click on the
Find button to locate any radiated emissions sessions in this file; the
search criteria is still the same.

7. Repeat steps 5 and 6 until all radiated emissions sessions have been found
and copied to the Radiated file.

The Select Session Search Criteria area uses the same fields and search
expressions as in searching for a session. Refer to the “Search Criteria” section
in this chapter  for more information.
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Deleting Data

The Edit, Delete menu item selects either a data item, session, or session group
for deletion. However, header data is deleted via the Edit, Clear Header Data
menu. If you change your mind or make a mistake, you can reverse a delete
action by using Edit, Undo.

Item

Deletion of data items is accessed via the Edit, Delete, Item menu and is only
available when a data item has been highlighted in the active session. If the data
item window is open, it is closed.

It should be noted that the only data item that cannot be deleted is the Session
Header.

To delete a data item

1. Highlight the data item you wish to remove on the session pane.

2. Do one of the following:

•  From the Edit menu, choose Delete, Item.

•  Click the right mouse button, then choose Delete.

•  Press the Delete key on the keyboard.
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Session

Deletion of a session is accessed via the Edit, Delete, Session menu and is only
available if the file contains test sessions. When a session tab is highlighted, it
becomes the active session and can be deleted from the file after the Delete
Session Message is displayed confirming the action. If any data item windows
are open, they are closed.

To delete a session

1. Highlight the tab of the session you wish to remove.

2. Do one of the following:

•  From the Edit menu, choose Delete then Session.

•  Press the Delete key on the keyboard.

3. When the Delete Session Message is displayed, click OK.

Session Group

Deletion of a session group is accessed via the Edit, Delete, Session Group
menu and is only available if the file contains test sessions. When selected, the
Delete Session Group dialog box appears which is similar to the Find Session
dialog box in that it allows you to find sessions based on matching selected
header fields. The Find button displays a list of the sessions that match the
search criteria in the Sessions Found list area. If Find All is used, all sessions
are displayed, independent of the search criteria.

When a specific session in the Sessions Found list area is highlighted, its
header data is displayed in the list area at the bottom of the dialog box for
visual verification. In order to delete a session or group of sessions, the
session(s) need to be highlighted using a click, shift-click, or control-click from
the mouse. When one or more sessions is selected, the Delete button is
enabled. When the Delete button is pressed, a confirming dialog box appears. If
the action is confirmed with OK, the selected sessions are deleted from the file.
If any data item windows associated with the deleted test sessions are open,
they are closed.
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Find Locates only the test sessions in the specified file which
match the search criteria and places those sessions in the
Sessions Found list.

Find All Places all of the test sessions from the open file in the
Sessions Found List, independent of the search criteria.

Delete Removes the highlighted session(s) from the open file. The
Delete Session Group dialog box remains open.

Cancel Closes the Delete Session Group dialog box.

Clear Entries Clears all entries from the Search Criteria fields, leaving
them blank.

To delete a session group

1. From the Edit menu, choose Delete, Session Group.

2. In the Select Session Search Criteria area, select and enter the search
criteria information, and then choose the Find button.

All sessions that match the search criteria will be placed in the Sessions
Found list area.

3. In the Sessions Found list area, highlight the session(s) to be deleted, and
then choose the Delete button.

4. Choose the Cancel button to close the window.
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Header Data

Individual fields in the header can be deleted using standard Windows editing
methods. However, complete deletion of header data can be accessed via the
Edit, Clear Header Data menu. When selected, all editable data in the currently
active header is erased. It should be noted that the date/time and measuring
receiver fields are not editable and are not cleared, and that the Session Header
data item itself is not deleted from the session; only its data is cleared. The
changes are saved automatically when you leave the active session either by
selecting another session or exiting the application.

To clear header data

1. Select the tab of the session in which you wish to clear the header data.

2. From the Edit menu, choose Clear Header Data.

3. When the Clear Header Data Message is displayed, click OK.
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Undo of a Delete

The process of undoing an action is categorized in two ways: application and
session. Reversing application deletions pertain to the merge process, session
groups, and individual sessions. As long as you remain working in this file, any
of these application deletions may be reversed in the order that they were done;
that is, the undo command is buffered saving all of the deletions until you
change files.

Reversing deletions that relate to a session are: editing any header field; using
Edit, Clear Header Data; and cutting or deleting data items from a session. Any
of these session deletions remain in a buffer until you change sessions. For
example, if you clear the header data and delete the signal list data item of a
session, as long as you remain working in this session, you will be able to
retrieve either the header data or the signal list. However, if you select another
session for viewing prior to undoing these deletions then return to the previous
session, you will not be able to reverse the deletions.

If any combination of application and session deletions are done, as long as you
remain working in the same file, all application deletions can be reversed.
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Maintaining Files

If the HP 85878A software is terminated in an unusual way, such as in a power
outage, the file in which test sessions are saved may become corrupted. You
may repair any suspicious corrupted file by selecting the File, Maintenance
menu item and selecting the Repair File button. Repairing a file automatically
compacts it also.

Over time, HP 85878A files may become fragmented, using more disk space
than necessary. In order to remove this wasted space and perform the
compaction process, the Compact File button has been provided.

Browse Accesses the Open dialog box to specify the file to repair
or compact.

Repair File Fixes corrupted files due to unusual termination of the
application for reuse, for example, hardware failure. Any
open data item window will be closed with the use of this
button. The compact process is also performed as part of
the repair.

Compact File Removes wasted space in a file, reducing file size.

Done Closes the File Maintenance window without performing
any actions.
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Repairing a File

If you suspect a file is corrupted, use the File, Maintenance menu to attempt to
repair your file. Indications of a corrupted file may be such things as: a data
item may not open, error messages referencing “invalid bookmarks,” or header
data is not properly displayed. When this occurs, it is recommended that you
first try to “repair” the file by using the File, Maintenance menu selection. It
should be noted that the repair process attempts to restore a file to its normal
state. Depending on the severity of the corruption, loss of data may be
unavoidable.

Repair File Example

In the case that a file is corrupted such that it cannot be opened during startup
of the HP 85878A application, use the following to attempt to repair the
corrupted file:

1. Close the HP 85878A application.

2. Use Windows Explorer to rename the corrupted file.

3. Restart the HP 85878A application again and follow the prompts to open it
successfully.

4. From the File menu, choose Maintenance to open the File Maintenance
dialog box.

5. Specify the corrupted file in the File to repair or compact field, then choose
the Repair File button.

6. After the repair process is complete, the File Maintenance Message is
displayed; click the OK button to close this message.

7. Choose the Done button to close the File Maintenance dialog box.

8. From the File menu, choose Open to open the repaired file. If the
previously corrupted file opens, the repair was successful; if it does not
open, the file is unrepairable.
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To repair a file (that can be opened from the HP 85878A application)

1. From the File menu, choose Maintenance.

2. Select the Browse button to specify the directory and file.

3. Choose the Repair File button.

4. Choose the Done button to close the window.

Compacting a File

If you delete sessions from a file, it can become fragmented and use disk space
inefficiently. Compacting the file rearranges how the data is stored in the file.

To compact a file

1. From the File menu, choose Maintenance.

2. Select the Browse button to specify the directory and file.

3. Choose the Compact File button.

4. Choose the Done button to close the window.
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Chapter 7  

Printing Data

Data can be printed from either the HP 85878A main menu or directly from a
data item. Printing from the HP 85878A main menu brings up a dialog box
which allows you to select any combination of data items to print. After those
are selected, a standard Window’s print dialog appears from which the print can
be initiated. A print from a data item window prints all the data of that item.

This chapter describes the following printing methods:

•  Printing from the HP 85878A Main Menu

◊ Print Setup

•  Printing from Data Item Menu

•  Printing from Pop-up Menu
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Printing from the HP 85878A Main Menu

Printing from the HP 85878A main menu File, Print Data accesses the Print
Data dialog box. Only the data items that are present in the currently active
session are available for printing; the unavailable data items are disabled. At
this time, you may check any number of available data items to be printed.
When a data item has been selected, a red check will appear on the icon.
Choose the OK button to print the contents of the selected data items.

To print from the HP 85878A main menu

1. Do one of the following:

•  From the File menu, choose Print Data.

•  On the toolbar, click the Print Data icon.

2. Check the data item(s) that you want to print.

3. Choose the OK button.
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Print Setup

The Properties dialog box for your default Windows printer is configured based
on the printer configuration for your system.

To set up printer properties

1. From the File menu, choose Print Setup.

2. Specify the printer properties you want to use.

3. Choose the OK button.
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Printing from a Data Item Menu

Each data item present in the currently active session is available for printing.

To print from a data item menu

1. Double-click on the data item to open it.

2. From the data item menu, select File then Print.

3. The Print dialog box appears. You now have the option to specify another
printer and associated properties and the number of copies you would like.

4. Choose the OK button.
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Printing from a Pop-Up Menu

You can print the contents of a data item directly from the active session.

To print from a pop-up menu

1. Position the cursor over the data item and click the right mouse button.

2. From the pop-up menu, choose Print.

3. The Print dialog box appears. You now have the option to specify another
printer and associated properties and the number of copies you would like.

4. Choose the OK button.
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Chapter 8  

Exporting Data

Data items can be exported to other files either from the HP 85878A main
menu or directly from a data item. Exporting from the HP 85878A main menu
allows you to specify multiple data items at one time and the associated
filename in which you want to save them under. For text items with columns of
data—signal list, trace A, trace B, trace C, limit lines, correction factors,
session header, and instrument settings—the format options in which to store
each item are: space-separated, tab-separated, or comma-separated; the
extension for the text format options is .TXT. For the graphical items--screen
capture, linear plot, and log plot—the format options are: Windows Bitmaps
(.BMP), PC Paintbrush (.PCX), Graphics Interchange Format (.GIF), HP
Graphics Language (.HGL), or Tagged Image File Format (.TIF). The
Annotation data item, saved as unformatted text (.TXT), is not affected by
either of the format options.

This chapter describes the following exporting methods:

•  Exporting Files from the HP 85878A Main Menu

•  Exporting Files from a Data Item Menu

•  Exporting a File from a Pop-up menu
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Exporting Files from the HP 85878A Main Menu

To export files from the HP 85878A main menu, use File, Export Data to
access the Export Data dialog box. Only the data items that are present in the
currently active session are available for exporting; the unavailable data items
are disabled. At this time, you may check any number of available data items
to be exported. When a data item has been selected, a red check will appear on
the icon. The filenames displayed next to the data item icons are the default
filenames that will be used for export; use these text fields to enter a different
name. Filenames can be up to 255 characters long, which includes the path. The
Browse button allows you to select the directory in which the files will be
saved. When OK is selected, the specified data items are stored in the
specified formats under the specified filenames. The default destination
directory for the exported data items is: \HP85878A\Export\. This can be
changed by typing in a new directory or by using the Browse button.



Exporting Data • 8-3

For data items using columns of data—signal list, trace A, trace B, trace C,
limit lines, correction factors, session header, and instrument settings—the Text
Format options are:

•  Comma-Separated (.TXT)

•  Tab-Separated (.TXT)

•  Space-Separated (.TXT)

For the graphical items—screen capture, linear plot, and log plot—the Graphics
Format options are:

•  Windows Bitmaps (.BMP)

•  PC Paintbrush (.PCX)

•  Graphics Interchange Format (.GIF)

•  HP Graphics Language (.HGL)

•  Tagged Image File Format (.TIF)

The Annotation data item is not affected by either of the format options and is
always stored as unformatted text (.TXT).

To export files from the HP 85878A main menu

1. Do one of the following:

•  From the File menu, choose Export Data.

•  On the toolbar, click the Export Data icon.

2. Use the Browse button to specify the destination directory for the exported
files.

3. Check the data item(s) that you want to export and rename any files, if
necessary.

4. Specify the Text Format and Graphics Format options for the data items
selected.

5. Choose the OK button.
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Exporting Files from a Data Item Menu

Each data item present in the currently active session is available for exporting.

To export a file from a data item menu

1. Double-click on the data item to open it.

2. From the data item window menu, select File then Export.

3. The Export dialog box appears. You now have the option to specify the
destination directory, filename, and format option of the data item being
exported.

4. Choose the OK button.
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Exporting a File from a Pop-Up Menu

You can export the contents of a data item directly from the active session.

To export a file from a pop-up menu

1. Position the cursor over the data item and click the right mouse button.

2. From the pop-up menu, choose Export.

 The Export dialog box appears. You now have the option to specify the
destination directory, filename, and format option of the data item being
exported.

3. Choose the OK button.
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Chapter 9  

Customer Support

Your EMI software is designed to provide dependable service. It is unlikely
that you will experience a problem. However, Hewlett-Packard's worldwide
sales and service organization is ready to provide the support you need.

If You Have a Problem

If you have a problem, refer to the following for possible help:

•  HP 85878A User's Guide

•  Online Help

•  Readme file

•  Respective documentation for:

◊ National Instruments AT-GPIB/TNT interface card

◊ HP 82341C (HP-IB) interface card

If you still have a problem, please read the warranty printed at the front of this
manual, then contact the nearest HP Sales and Service Office. If our EMI
software is covered by a separate support agreement, please be familiar with its
terms.
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Service Menu

You can access the Service dialog box under Help, Service in the main menu of
the HP 85878A application. This has been provided to help you and your HP
service personnel in troubleshooting any problems you may have with the
application. The Service dialog box consists of the following three tabs: Status,
Test Bus, and Logger.

Status displays the current filename and associated path, file size,
interface type, and receiver address being used.

Test Bus checks the communication path by testing the I/O bus when the
Start Test button is pressed. The results from the test appear in
the Test Results text box.

Logger Logs diagnostic text to a file. The functions available on this
tab are: selecting what information to log (Log Errors or Log
Bus Traffic), starting and stopping the logging, viewing the log,
and clearing the log. If the log viewer is open with logging
turned on, it is updated in real time as logging occurs.
Additionally, the log viewer provides a File menu with Save
As and Close commands, and an Edit menu with Copy and
Select All commands, allowing the current contents of the log
to be easily manipulated in ASCII format. The contents of the
log is also saved to the default log file HP85878A.log located
in the HP 85878A application directory.
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Additional Support Services

Using Online Help

Online Help provides a convenient, quick way to look up information about a
feature you would like to know more about. You can access Help through the
Help menu or by pressing F1 to get context-sensitive Help.

Help Contents

For information on Help topics, choose Contents from the Help menu. You can
use the Contents screen to get quick access to key reference topics.

Help Search

The fastest way to find a particular topic in Help is to use the Search dialog
box. To display the Search dialog box, you can either choose Help Search from
the Help menu or click the Search button on any Help topic screen.

Context-Sensitive Help (F1)

All EMI measurement software windows are context-sensitive. Press F1 to get
context-sensitive Help directly without having to go through the Help menu.

Calling HP Sales and Service Offices

Sales and service offices are located around the world to provide complete
support for your EMI software. To obtain support information, contact the
nearest Hewlett-Packard Sales and Service office listed in Table 9-1. In any
correspondence or telephone conversations, refer to the EMI software by its
product number and full serial number.  With this information, the HP
representative can quickly determine whether your unit is still within its
warranty period.
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 Table 9-1.  Hewlett-Packard Sales and Service Offices

US FIELD OPERATIONS

Customer Information

Hewlett-Packard Company

19320 Pruneridge Avenue

Cupertino, CA 95014, USA

(800) 752-0900

California, Northern

Hewlett-Packard Co.

301 E. Evelyn Avenue

Mountain View, CA 94041

(415) 694-2000

California, Southern

Hewlett-Packard Co.

1421 South Manhatten Ave

Fullerton, CA 92631

(714) 999-6700

Colorado

Hewlett-Packard Co.

24 Inverness Place

East Englewood, CO 80112

(303) 649-5000

Georgia

Hewlett-Packard Co.

2124 Barrett Park Drive

Kennesaw, GA 30144

(404) 955-1500

Illinois

Hewlett-Packard Co.

5201 Tollview Drive

Rolling Meadows, IL 60008

(708) 342-2000

New Jersey

Hewlett-Packard Co.

150 Green Pond Road

Rockaway, NJ 07866

(201) 586-5400

Texas

Hewlett-Packard Co.

930 E. Campbell Road

Richardson, TX 75081

(214) 231-6101

EUROPEAN FIELD OPERATIONS

Headquarters

Hewlett-Packard S.A.

150, Route du Nant-d’Avril

1217 Meyrin 2

Geneva, Switzerland

(41 22) 780.8111

France

Hewlett-Packard France

1 Avenue Du Canada

Zone D’Activite De Courtaboeuf

F-91947 Les Ulis Cedex

France   (33 1) 69 82 60 60

Germany

Hewlett-Packard GmbH

Hewlett-Packard-Strasse

61352 Bad Homburq

Germany

(+49 6172) 16-0

Great Britian

Hewlett-Packard Ltd.

Eskdale Road, Winnersh Triangle

Wokinglam, Berkshire RG11 5DZ

England (44 734) 696622

INTERCON FIELD OPERATIONS

Headquarters

Hewlett-Packard Company

3495 Deer Creed Road

Palo Alto, CA 94304-1316

(415) 857-5027

Australia

Hewlett-Packard Australia Ltd.

31-41 Joseph Street

(P.O. Box 221)

Blackburn, Victoria 3130

(61 3) 895-2895

Canada

Hewlett-Packard (Canada) Ltd.

17500 South Service Road

Trans- Canada Highway

Kirkland, Quebec H9J 2X8

(514) 697 4232

China

China Hewlett-Packard Co.

38 Bei San Huan X1 Road

Shuang Yu Shu

Hai Dian District

Beijing, China

(86 1) 256-6888

Japan

Yokogawa-Hewlett-Packard Ltd.

1-27-15 Yabe, Sagamihara

Kanagawa 229, Japan

(81 427) 59-1311

Singapore

Hewlett-Packard Singapore

(Pte.)Ltd.

Alexandra P.O. Box 87

Singapore 9115

(65) 271-9444

Taiwan

Hewlett-Packard Taiwan

8th Floor, H-P Building

337 Fu Hsing North Road

Taipei, Taiwan

(886 2) 712-0404
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Appendix A

Hardware Interface Installations

The HP 85878A software uses one of the following interface types with the
EMC analyzer to make your EMI measurements.

•  AT-GPIB/TNT(PnP)

•  AT-GPIB/TNT

•  HP-IB interface

•  RS-232 serial interface

The computer uses the software to communicate with the EMC analyzer via the
interface card or port. The sections which follow explain how to install and
configure the various cards or ports that support the HP 85878A software.

Note  The following are the major steps needed to configure the hardware,
install the software, and verify the hardware operation. For complete
installation and configuration instructions, refer to the documentation shipped
with your interface package.
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Setup of AT-GPIB/TNT(PnP) for Windows 95

There are three basic steps for installing and configuring the
AT-GPIB/TNT(PnP) card.

1. Software installation

2. Hardware setup and installation

3. Verification

Note  For this installation, the software must be installed before the hardware.

Software Installation AT-GPIB/TNT(PnP)

1. From the Windows 95 Start menu, select Settings, Control Panel, then
double-click on the Add/Remove Programs icon.

2. Insert the GPIB Software for Windows 95 setup disk into the disk drive.

3. In the Add/Remove Programs Properties window, select the
Install/Uninstall tab and click on the Install button.

4. Follow the setup instructions displayed on the computer screen to complete
the installation.

Hardware Setup and Installation AT-

GPIB/TNT(PnP)

1. Shut down Windows 95 and turn off the computer.

2. Remove the computer cover and install the GPIB interface card. If possible,
avoid using the first or last slot as it is difficult to connect the GPIB
interface cable with the card in either of these locations.

3. Turn on the computer. When Windows 95 is loaded, the message “New
Hardware Found. National Instruments AT 488.2 Plug and Play” is
displayed.

4. From the Windows dialog box, click OK to select the default driver.

The installation is now complete.
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Verification AT-GPIB/TNT(PnP)

It is important to test your hardware configuration before attempting to use the
AT-GPIB interface. Use the following procedure to verify correct operation.

1. From the Windows 95 Start menu, select Programs, NI-488.2 Software
for Windows 95, then Diagnostics.

2. In the Diagnostics window, select Test All.

3. When the message “Please close all GPIB applications” appears, select
OK.

4. When the test is complete, the message “Passed” will be displayed. Select
Exit.

5. Click on the Windows 95 Start button and select Settings then
Control Panel.

6. In the Control Panel window, double-click on the System icon.

7. In the System Properties window, select the Device Manager tab then
double-click on National GPIB Interface.

8. Select AT-GPIB/PnP then click on the Properties button.

9. In the AT-GPIB/PnP Properties window, select the Resources tab.

10. Verify that there are no conflicts.

 If there are no resource conflicts, the interface card should work properly. In
case of conflicts (that is, if there are no IRQs available on the computer),
refer to Appendix C in the Getting Started with Your Plug and Play GPIB
Hardware and Software for Windows 95 document.

11. Click the OK button to close the AT-GPIB/PnP Properties window.

12. Click the OK button to close the System Properties window.
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Setup of AT-GPIB/TNT for Windows 95

There are four basic steps for installing and configuring the AT-GPIB/TNT
card.

1. Software installation

2. Hardware configuration

3. Hardware installation

4. Hardware verification

Note  The drivers shipped with the TNT card will not work under Windows 95.
Download the driver for Windows 95 Version 1.1, or later, from the National
Instrument’s Web site at http://www.natinst.com. For this installation, the
software must be installed before the hardware.

Software Installation (AT-GPIB/TNT)

1. From the Windows 95 Start menu, select Settings, Control Panel, then
double-click on the Add/Remove Programs icon.

2. Insert the NI-488.2 Software for Windows and the AT-GPIB/TNT disk 1
into the disk drive.

3. In the Add/Remove Programs Properties window, select the
Install/Uninstall tab and click on the Install button.

4. Follow the setup instructions displayed on the computer screen to complete
the installation. From the GPIB setup options, select the GPIB setup
option from the NI-488.2 (M) software. (Do not use the option for the
GPIB analyzer. This does not pertain to the HP 85878A software.)
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Hardware Configuration (AT-GPIB/TNT)

Follow the procedure below to configure the hardware BEFORE it is installed.

1. From the Windows 95 Start menu, select Settings, Control Panel, then
double-click on the Add New Hardware icon.

2. Start the Add New Hardware wizard by clicking on Next. When it prompts
you to search for hardware, click on No. (No is selected at this time
because the hardware has not been installed yet.)

3. Click Next to display the hardware types list, then double-click on
National Instruments GPIB Interfaces.

4. Select the AT-GPIB/TNT model, then click Next.

5. The Add New Hardware wizard will display the DMA, I/O range, and
Interrupt Request for the AT-GPIB/TNT card.

6. Use the settings from the step above to configure the AT-GPIB/TNT card.
Refer to the AT-GPIB/TNT Getting Started manual to assist you with this
procedure.

7. When Windows 95 has finished installing the software necessary for
supporting your hardware, click on Next to end the installation. When the
software prompts you to power down the computer, click on Yes.

Hardware Installation (AT-GPIB/TNT)

1. Shut down Windows 95 and turn off the computer.

2. Remove the computer cover and install the GPIB interface card. If possible,
avoid using the first or last slot as it is difficult to connect the GPIB
interface cable with the card in either of these locations.

3. Turn on the computer to start Windows 95.
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Hardware Verification (AT-GPIB/TNT)

1. From the Windows 95 Start menu, select Settings then Control Panel.

2. In the Control Panel window double-click on the System icon.

3. In the System Properties window, select the Device Manager tab then
double-click on National Instruments GPIB Interfaces.

4. Select AT-GPIB/PnP then click on the Properties button.

5. In the AT-GPIB/PnP Properties window, select the Resources tab.

6. Verify that the I/O range, DMA, and Interrupt Request are the same values
as what were set on the card and that there are no conflicts.

7. Click the OK button to close the AT-GPIB/PnP Properties window.

8. Click the OK button to close the System Properties window.

9. To test the AT-GPIB/TNT card, select the Windows 95 Start  button,
Programs, NI-488.2M Software for Windows 95, then Diagnostics.

10. In the Diagnostics window, select Test All.

11. When the message “Please close all GPIB applications” appears, select
OK.

12. When the test is complete, the message “Passed” will be displayed. Select
Exit.

If the test does not pass, refer to the At-GPIB/TNT Getting Started manual for
more information.



Hardware Interface Installations ••••  7

HP-IB Interface

The HP-IB interface card (HP 82341C) can be configured and installed using
the following steps:

1. Hardware installation

2. Software installation

3. Hardware verification

Hardware Installation (HP 82341C)

1. Shut down Windows 95 and turn off the computer.

2. Remove the computer cover and install the HP-IB interface card. If
possible, avoid using the first or last slot as it is difficult to connect the
GPIB interface cable with the card in either of these locations.

 Use the default switch settings on the HP 82341C card.

3. Turn on the computer to start Windows 95.

Software Installation (HP 82341C)

1. Place the HP I/O Libraries for Instrument Control compact disc (CD) into
the CD drive of your computer to load the HP 84231C software.

2. From the Windows 95 Start menu, select Run.

3. In the Run dialog box, select the CD ROM drive. Use the Browse button if
you do not know the location of the CD ROM drive.

4. Select Setup.exe to load the driver.

5. In the HP I/O Libraries Installation window, select Windows 95.

6. Verify the SICL and VTL file locations then press Install.

7. When the installation is complete, the message “Installation Succeeded”
will be displayed. Click OK.



8 ••••  Hardware Interface Installations

8. To complete the configuration, select the Windows 95 Start button,
Programs, HP I_O LIBRARIES, then I_O Config.

9. In the Interface Configuration Application-I/O Config window, select the
HP 82340/82341 HP-IB in the Available Interface Types area then click
Configure.

10. Make any necessary changes then click OK.

11. When the driver is successfully installed, recycle the power and restart
Windows 95.

Hardware Verification (HP 82341C)

1. From the Windows 95 Start menu, select Settings then Control Panel.

2. In the Control Panel window, double-click on the System icon.

3. In the System Properties window, select the Device Manager tab.

4. Verify that HP-IB is listed.

There is no diagnostic test for the HP-IB card.
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RS-232 Serial Interface

To use the RS-232 serial interface with the HP 85878A software, the
HP 85878A software must first be installed.

1. From the Windows 95 Start menu, select Programs, HP EMI, then
HP 85878A Serial Config.

2. To use the HP 85878A software with the RS-232 serial interface, select
RS-232 from the Available Interface Types area, then click on Configure.

Verify that the baud rate matches in the following three areas:

•  HP 85878A application (located in the Configure dialog box)

•  EMC analyzer (located under the [CONFIG] key)

•  HP 85878A Serial Config application (located in the RS-232 / Serial
Configuration dialog box)

1. Make any necessary changes then click OK.

2. To exit the I/O Config window, click OK again.

3. Recycle the power and restart Windows 95. The COM channel will not
function properly until the power has been recycled.
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